
RELEASE NOTES

Release Notes for Mari 3.3v1

Release Date
24 May 2017

System Requirements
NOTE: Mari increases its level of performancewith newer, more advanced hardware configurations.
However, Mari is tested and capable of operating onmany older, prior-generation systems. For this reason
we are listing below-minimum requirements, which are recommended, and on which tests have been
performed. Your particular needsmay vary from that of other users.

Officially Supported Operating Systems
• Mac OS X 10.10 (Yosemite) or higher

• Windows 7 64-bit or higher

• Linux 64-bit operating system (CentOS/RHEL 6)

Minimum Hardware Requirements
• Quad-core processor

• 10+GB disk space available for caching and temporary files

• At least 4GB RAM

• Display with 1680 x 1050 pixel resolution

• An NVIDIA or AMD* graphics card with the latest drivers

• 1GB of graphicsmemory

• OpenGL 3.2* or higher

*Displacement preview is currently only available on the cards and drivers that support OpenGL 4.0 or newer.
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Recommended System Requirements
• 2.5+Ghz Quad-core processor

• 250+GB disk space available for caching and temporary files. SSD is preferable.

• 16GB RAMwith additional virtual memory*

• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD* graphics card with the latest drivers

• 2+GB of graphicsmemory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

'Recommended' does not guarantee that it meets your particular needs.

Tested Workstation Hardware

The configurations listed below are those that The Foundry have tested with Mari. Due to the constantly changing
nature and wide variety of computer hardware available in themarket, The Foundry is unable to officially certify
hardware. The list below can be used as a recommendation and does not guarantee that it meets your particular
needs.

Please download and install the latest graphics driver from theNVIDIA or AMD websites, and ensure that you are
using 8.982.1 drivers or higher for AMD cards.

If you encounter any issues, please contact Customer Support directly through the Support Portal at the following
address: https://support.foundry.com.

Tested Workstation Hardware

Apple • MacPro4,1

• MacPro6,1

• iMac13,2

• MacBookPro9,1

• MacBookPro10,1

HP • HP XW6600

• HP Z600

• HP Z620

• HP Z640
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Tested GPU Hardware

AMD Prosumer Graphics Cards • AMD Radeon HD - D500

NVIDIA Prosumer Graphics Cards • NVIDIA Geforce GTX 660TI

• NVIDIA Titan X

• NVIDIA Geforce GT 650M

• NVIDIA Geforce GT 675M

NVIDIA Enterprise Graphics Cards • NVIDIAQuadro 4000

• NVIDIAQuadro K4200

• NVIDIAQuadro K5000

• NVIDIAQuadro M6000

• NVIDIAQuadro M6000 24GB

New Features

Shader Compilation
• BUG ID 246716 - Shaders now require fewer recompilations (the spinning wheel) when performing certain
repeated tasks, reducing thewaiting time between performing an action and viewing the final rendered shader. See
GPU > General > Shader Compilation in theMari Preferences Dialog section of theMari Online Help.

Colorspace Export Optimization
• BUG ID 251019 - Some colorspace transformations have been introduced to allowMari to bake the paint to disk at
a faster speed. SeeData > Channels > Export Transform in theMari Preferences Dialog section of theMari
Online Help.

Lift Option in theMarquee Select Tool
• BUG ID 245977 - After performing amarquee selection, you can now lift the texture from the current paint target
to the paint buffer for furthermanipulation. SeeMarquee Select Tool > Lift Marquee Selection in the Tool
Properties Palette section of theMari Online Help.

Optimized Texture Unit Usage
• BUG ID 246731 - Mari now combinesmultiple textures into one optimized unit, so that you can work on projects
with a higher level of complexity, without reaching graphics capacity limits.
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Baking Bake Point Nodes in the Node Graph
• BUG ID 246218 - You can now bake the Bake Point nodes that have never been baked before or are out-of-date,
directly in theNodeGraph by right-clicking and selecting Edit > Bake Points > Smart Bake And Update. You can
also bake the selected Bake Point nodes using the samemenu. See theWorking with Nodes and Node Graph
Functions sections of theMari Online Help.

Feature Enhancements
• BUG ID 231484 - TheUV View has been updated to reflect selection changes in theNodeGraph.

• BUG ID 240086 - Nodes using the Locator list attributewere always bound to their selected locators.
Now the Locator list attribute has its own transformation controls in case of an empty or deleted locator.

• BUG ID 240928 - TheChannel and Layer palettes' icons have been improved.

• BUG ID 249581 - The environment light cache has been updated to prefix the artist's environment, so as to ensure
the correct environment light cache is generated and used on the artist's machine.

• BUG ID 264159 -mGo now includes extra colorspace options forMaya.

• BUG ID 267533 - Mari now includes new channel presets formultiple workflow and shader types. Formore
information, see the Shading Networks > Channels > Creating Multiple Channels from Presets section of theMari
Online Help.

Bug Fixes
• BUG ID 113082 - Vector4f and other vector types in layer and shader nodes didn't respect theMari Preferences
>Misc > Slider Precision preference.

• BUG ID 169007 - After exporting a session, an unnecessary dialog displayed prompting the artist to wait for the
background tasks to finish.

• BUG ID 172068 - Therewas no example .xml code for registering a customnode through theNodeGraph.

• BUG ID 173722 - Palettes often opened behind other palettes, making it difficult to seewhere the additional
palettes' tabs had appeared.

• BUG ID 175682 - In theChannels palette, double-clicking the layer stack button of a channel that had been
created in theNodeGraph, causedMari to crash.

• BUG ID 197699 -When exporting the current channel, the colorspace did not default to the channel colorspace.

• BUG ID 198182 - In theNode Graph palette, right-clicking and navigating to File > Export didn't work correctly
whenmaking edits in the current Node Graph.

• BUG ID 198243 - In theNew Project dialog, underMesh options, loading an .fbx file and setting the End Frame
value above themaximum causedMari to crash.

• BUG ID 218236 - Closing customwidgets with the blend option and opening theManage Keyboard Shortcuts
dialog causedMari to crash.
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• BUG ID 224789 - Adding a PySidewidget to several Mari tabs causedMari to crash due to a PySide reference count
issue.

• BUG ID 227940 - Mari recompiled shaders after unplugging a pipe from a node and before plugging it into another
node.

• BUG ID 228064 - Editing the Z Order value of a Backdrop nodewas very slow and causedMari to crash.

• BUG ID 228370 - TheNode Graph palette'sminimap lagged behind the cursor.

• BUG ID 229299 - In theNodeGraph, using the AiStandard shader changed the input order when saving and
exiting.

• BUG ID 229805 - In the Lights palette, addingmore Texture > Blur to the Environment light produced an
incorrect NdotL image cube and rendered as a solid cube.

• BUG ID 231481 - The patch resolution display did not updatewhen selecting andmanipulating nodes in theNode
Graph.

• BUG ID 234201 - Editing theBlending property in Merge nodes didn't show the spinning wheel in the Viewer and
madeMari become unresponsive.

• BUG ID 234745 - Mari filled logs with unnecessary Failed to disconnectmessages.

• BUG ID 235424 - Baking did not project paint on someparts of the object when the object was shifted by the
Zoom Paint Buffer tool.

• BUG ID 241006 - Mari became unresponsive on start-up when strict parsing was enabled in theOCIO config file
specified through theOCIO environment variable.

• BUG ID 241667 - Opening an .abc file with Ptex causedMari to crash.

• BUG ID 241774 - Nodes returned an incorrect proceduralType value as they were not being upgraded correctly
when ran in terminalmode.

• BUG ID 243388 - The Paint Through tool produced a lower quality result when painting compared to stamping.

• BUG ID 243473 - Objects in Ptex projects became unpaintable if the project had previously been closed without
saving.

• BUG ID 245661 - The lights setup was incorrect after importing certain sessions. Mari didn't have an option to
export the default cameras: Ortho, Perspective, and UV.

• BUG ID 246081 - Importing, closing, and re-opening a session causedMari to crash.

• BUG ID 246631 - Loading objects with no UV didn't switch to Ptex and causedMari to crash eventually.

• BUG ID 247028 - Changing the colorspace in the color picker with certain OCIO config files sometimes causedMari
to crash.

• BUG ID 247381 - Loading a session containing any node from the Extension Pack, or adding a procedural node
from the Extension Pack, causedMari to crash.

• BUG ID 247387 - Importing session scripts failed with old archives when trying to load internal Mari data types.

• BUG ID 247407 - Group nodes were incorrectly parsed and, as a result, rendered incorrectly.

• BUG ID 248385 - Copying and pasting patches didn't copy across the colorspace configuration and rendered
incorrectly.

• BUG ID 248505 - Attaching lights to the camera caused the colors displayed in the Viewer to be permanently blown
out.
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• BUG ID 248693 -When creating a 16/32-bit floating-point channel, the output colorspace default valuewas set to
sRGB, rather than linear.

• BUG ID 249776 - Closing theColors palette's floating tabs causedMari to crash.

• BUG ID 251073 -When converting to a later version of Mari, the environment light did not render correctly due to
missing colorspace information from a previous version.

• BUG ID 252397 - Mari required that the active_displays and active_views fields be present in all OCIO configs.
This conflicted with theOCIO syntax rules, which state that they should be optional.

• BUG ID 252771 - Channelmasks did not evaluate the layer used as amask.

• BUG ID 265806 - Executemode (-x) did not block theUI dialog boxes.

• BUG ID 266158 - Loading gizmos causedMari to crash.

• BUG ID 266160 - Gizmoswere loading very slowly and related changes within the gizmos triggered redundant
parsing of theNodeGraph, causingMari to slow down considerably.

• BUG ID 266407 - Switching theOCIO Config file resulted in invalid colorspaces if the colorspacewasn't part of the
newOCIO Config file.

• BUG ID 269008 - Exporting channels in Mari 3.2v1 failed when the Layers palette was hidden.

• BUG ID 270008 - The Edge Mask default values, Falloff End and Falloff Start, were set to 0.0, making it
impossible to see the effect after enabling it.

Known Issues and Workarounds

Mari Tools
• BUG ID 13640 - TheBlur tool can be slow to use on the initial stroke.

Wait forMari to process the blur before applying a second stroke.

• BUG ID 13394 - Using the Select Items tool with the Facing set to Front to select and hide a portion of faces
causes some of the faces within the selection to remain visible when zoomed in.

To catch all selected faces, either:

• select Facing > Through instead of Front, or

• zoom in closer to the object.

Shaders
• BUG ID 34729 - Mari displays a rendering error on the canvas when it is unable to create a shader. More
information has been included to help you determine the cause of the error. Some solutionsmight be to hide
groups and layers, or to cache parts of your layer stack until a shader can be created.

• BUG ID 34679 - On extremely large projects, issues can arisewith shader limits, and reaching themaximumallowed
texture slots available. To avoid reaching these shader limits on large projects, try the following workarounds:

• hide groups and layers, or
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• cache groups and layers.

Layers
• BUG ID 34690 - Flattening or caching layers or channels on complex projectsmay causeWindows to reset the
graphics driver due to the long processing time. To work around this issue, you can try to flatten or cache fewer
layers at a time, or reduce the value of theMax Render Size For Baking setting. This setting can be found under
Preferences > GPU > Baking and Projection.

Reducing this size breaks the flattening or caching operation up into smaller pieces, which individually take less time
to calculate, and thereby avoids aWindows graphics driver reset.

• BUG ID 26460 - Painting amask in aMask Layer Group sometimes results in unexpected paint results. To prevent
this fromhappening, either:

• Use awhite “color” layer at the bottomof yourmask stack. Any layer used over this initial “color” layer should
then be fine, or

• If you want to create amask in aMask Layer Group, simply add another layer on yourMask Layer Group
instead, and paint white into it to create amask.

Importing and Exporting
• BUG ID 51655 - Mari becomes unresponsivewhen attempting to export Ptex textures.

• BUG ID 50886 - Session Scripts: Imported shaders don't have channels assigned.

• BUG ID 49131 - High polygon .obj files, exported using theOBJ Exporter plug-in, cannot be read back in to Mari.

• BUG ID 29386 -When using the Export for Maya script, Maya’s viewport may incorrectly show somepatches as
transparent. This can be resolved by selectingHigh Quality Rendering orViewport 2.0 from the Renderer
menu within Maya.

• BUG ID 16324 -Windows only: You cannot currently import an image into a channel using a relative file path. To
work around this, use an absolute path when importing images.

• BUG ID 14985 - Theremay be a slight pause after importing textures when creating new projects, whileMari saves
the project.

Nuke<>Mari Bridge
• BUG ID 23010 - Nuke<>Mari Bridge: If Mari crashes when receiving incoming components fromNukewhen the
Virtual Texture Type is set to Float, lower theVirtual Texture Size to a value below 8192x8192.

• BUG ID 19780 - Nuke<>Mari Bridge: A projector created inOrtho view inMari does not re-project correctly in
Nuke.

Ptex
• BUG ID 17626 - It can take a long time to import very large or very high polygon count Ptex models.
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Theworkaround is to assign a small uniform face size (1x1 or 2x2) on import, and then increase the resolution of
the relevant bits of themodel as necessary after loading.

• BUG ID 17618 - Ptex does not bake properly if the resolution of the face is too small.

Theworkaround is to increase the resolution of the selected faces you are having problemswith.

Graphics Cards
• BUG ID 217864 - Mac OS X only: AMD D500 and D700 graphics cards, found onmodernMac Pro's, are physically
limited to 16 TextureMapping Units, which can block operations such asmultiple procedural layers.

• BUG ID 207913 - Mari may crash, or operatewith lower than expected performance, when using recent graphics
drivers with someAMD cards.

There have been reports that Plays.tv and Raptr, which come bundled with the AMD FirePro drivers, can cause
instability in Mari. If you are experiencing instability, please try uninstalling these applications.

• BUG ID 18457 - Using NVIDIA graphics cards from the Fermi series with drivers older than version 270 results in
various rendering issues when theVirtual Texture Type is set toHalf or Float.

To resolve this, please download and install the latest graphics driver for your card from theNVIDIAwebsite.

• BUG ID 12567 - Enabling Sync to VBlank in NVIDIA settings can drastically reduceMari’s performance. If you
experience very slow interaction, even with low-polygonmodels, on one of the TestedWorkstation Hardware,
navigate to:

• Linux: NVIDIA X Server Settings > X Screen 0 > OpenGL Settings and turn off Sync to VBlank.

• Windows: NVIDIA Control Panel > 3D Settings > Manage 3DSettings > Vertical Sync > Force off

Then, restart Mari.

Node Graph
• BUG ID 168753 - AIStandard nodes created in Mari3.0v1 are not compatible with Mari 3.0v2, or later.

As aworkaround, remove the old AIStandard nodes and recreate them inMari 3.0v2, or later.

• BUG ID 51462 - Creating a shader and attempting to view it in theNode Graph palette gives the impression that
theDiffuseColor input edge ismissing from the shader node. The input is present, but is incorrectly hidden. This is
related to bug 51263 below.

• BUG ID 51452 -When importing a gizmo, the nodes in the gizmo do not retain their organization if they were
created using the itemname in themenu.

• BUG ID 51263 - It is not currently possible to attach the Viewer node to standardMari shaders, because they are
hidden.

As aworkaround, you can click theView the current channel button above theNodeGraph.

• BUG ID 51247 - Channel transfer doesn't transfer Graph Layers as expected.

• BUG ID 51082 - The Ambient Occlusion node's properties don't include a generate AO option.

• BUG ID 48790 -Autoplace does not respect Backdrop nodes.
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Miscellaneous
• BUG ID 226265 - Gray areas appear when changing theVirtual Texture Depth.

• BUG ID 221920 -When copying channels between objects, a warningmessage can pop up stating the requested
channel cannot be created. However, clickingOK to thismessage usually results in the channel copying
successfully, regardless.

• BUG ID 194832 - Bake times were significantly increased when baking into channels containing non-linear data.

• BUG ID 177430 - Mari occasionally crashes on startup during the initialization of Python.

• BUG ID 167883/51934 -When a project that contains a Tiled procedural is upgraded from 2.6 to 3.0, the frame
rate drops drastically.

• BUG ID 129292/51771 - Removing, changing, or hiding subdivided objects takes a long time.

To avoid this, replace the image in the Tiled procedural once the project has been upgraded.

• BUG ID 99115/46223 - The Sponge Desaturatemode does not work through the full dynamic range as it uses
HSL for desaturation. HSL cannot be used with HDR becauseHSL works well only in LDR values.

• BUG ID 51370 - Heavier projects are initially slower to render when colorspace is enabled.

• BUG ID 51322 - Modo Render: The preview occasionally fails to update fully.

• BUG ID 51273 - Mac OS X 10.10 and above: Rendering is occasionally incorrect when usingmultiple lights.

• BUG ID 51199 - The AiStandard, RedshiftArchitectural, and VRayMtl shaders are not connected to the Current
Channel automatically.

• BUG ID 51185 - PythonAPI: Mari's Paint node does not appear in typeList().

To add a Paint node Pythonically, call:
ng = mari.geo.current().nodeGraph()

ng.createPaintNode(width, height, bitDepth)

• BUG ID 51084 - Animated objects can take a long time to subdivide.

• BUG ID 50830 - TheObjects palette lock doesn't prevent objects frombeing transformed.

• BUG ID 50548 - Modo Render: Only cameramoves are respected by live update.

• BUG ID 50520 - Although faces with degenerate UVs can be loaded into Mari, they can cause issues in some cases.
They do not occupy any space in UV, so it's impossible to properly paint on such faces. There is also the risk that
some shadersmay show undesirable lighting effects on faces with degenerate UVs.

• BUG ID 50149 - Texture transfer does not take object transformation into account.

• BUG ID 50898 - Existing subdivision calculations are lost when recalculating, even if recalculation fails.

• BUG ID 49557 - Shadows and colors can appear incorrect after subdividing geometry.

• BUG ID 47180 - Mac OS X 10.10 and above: Resizing palettes is restricted to a certain width or height per drag
action.

• BUG ID 46600 - Ambient Occlusionmust be updated after any OpenSubdiv calculation.

• BUG ID 43020 - Mac OS X with retina screens only: When a hiddenmenu is unfurled over the canvas, the canvas
zooms in dramatically.
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• BUG ID 41573 -Windows 8 only: TheWindows key (Meta key) does not disengagewhen used in conjunction with a
Wacompen.

To successfully disengage, you need to press theWindows key again over the desktop, which rectifies the problem.

• BUG ID 37140 - Mac OS X only: By default, when you first install Mac OS 10.8 or higher, the security preferences
are set so that any applications not downloaded from the Apple App Store can’t be installed.
To ensure that Mari installs correctly, navigate to System Preferences > Security & Privacy on yourMac and
select Anywhere for theAllow applications download from field.

• BUG ID 33293 - Linux: LaunchingMari with the language set to onewithout certain character symbols resulted in
Mari failing with an error that the specified transform could not be loaded.

To work around this, set the locale (language) to English.

• BUG ID 31946 - Sometimes paint is not baked because of memory management issues on the graphics card. This
can be due to issues such as a high resolution paint buffer, a high bit-depth paint buffer, large virtual texture size,
or even a large scale value on the paint buffer transform. These issues can usually be identified by glError: 0x505
out of memorymessages in the log.

Try reducing any or all of these values to prevent it happening. Graphics drivers are continually improving, so it’s
also worth checking whether upgrading your drivers resolves the problem.

• BUG ID 20510 - If you find that the startup time forMari is longer than usual, please check that the LIC files in your
RLM licensing data folder do not refer to obsolete server ports. If they do, place them in another directory and
restart Mari.

• BUG ID 20021 - Textures in the canvas intermittently switch between lower and higher resolutions.

This issue ismore likely to occur if your virtual texture resolution is low, and you're working on a complex model
with displacement. Possible workarounds include increasing your virtual texture size, reducing the number of
channelsMari has to access at once (for example, by reducing the number of channels required for the current
shader), to reduce the patch resolution of patches in the channels used in the shader, or to use a smaller canvas
window ormonitor.

• BUG ID 14201 - Linux only: Mari becomes unresponsive after the system is woken from sleep.

• BUG ID 13700 - Adjusting theCamera > Perspective settings for a Projector is not reflected on the canvas until
the Projector is made Current.

• BUG ID 13571 - Launching a new version of Mari for the first time, when a config file exists from a previous version,
sometimes results in an object not appearing in theOrtho view.

To solve this, closeMari, delete the following config file and relaunchMari:

• Linux: ~/.config/TheFoundry/Mari.conf

• Windows: C:/Users/<login>/.mari/TheFoundry/Mari.ini

• BUG ID 13294 -Windows: Mari sometimes crashes when trying to load data on large projects due to the program
exhausting all windowmanager objects.

To reconfigure the user object limit:

• Open regedit and navigate toHKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windows\NT\CurrentVersion\Windows, and

• Edit USERProcessHandleQuota to a larger number.

If this number gets too large, youmay also have to modify GDIProcessHandleQuota.
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• BUG ID 12102 - Current brush settings do not get saved as part of the project. Instead, Mari reverts to the default
settings when you close and relaunch it.

• BUG ID 11874 - Mari doesn’t recognize 3-digit padded .obj sequences as animation.

• BUG ID 118830 - It is sometimes difficult to resize undocked palettes on OS X operating systems due to a bug in
Qt.

Developer Notes
These are the changes relevant to developers.

New Features
• BUG ID 243550 - Thereweremany unnecessary PythonQt references in the Python code and the API
documentation.

• BUG ID 243550 - Mari's Python API now returns a list of compressionmethods and the default compression
method for a given file extension.

Feature Enhancements
• BUG ID 107665 - Mari now includes the following Python API functions to query the status of background running
jobs:

• Application.isBackgroundJobFinished( 

• Application.backgroundJobIDs()

• Application.backgroundJobCaption()

• BUG ID 264752 - Mari log now includes a line to explain the requiredMax Render Sizefor Baking when a bake
operation fails, for example:
Debug : [     MriShaderBakeRenderOp.cpp:568 ] : Bake limited by 'Max Render Size for
Baking' preference. Currently '256 x 256', required '1024 x 1024'

Bug Fixes
• BUG ID 238929 - Exporting session scripts filled the Python console with unnecessary messages.

• BUG ID 248067 - Importing a session exported fromMari 3.1 caused a colorspace error in the Python console.

• BUG ID 249937 - The list of Python OpenEXR compression options was not documented.

• BUG ID 264638 - Mirroring geometry through the Python API causedMari to crash.

• BUG ID 270024 - Using the ProjectInfo.isNull() Python function causedMari to crash.

• BUG ID 271794 - In the Python console, creating a mari.Matrix()causedMari to crash.

• BUG ID 272563 - Themari.Image.ENABLE_FULL_PATCH_BLEED andmari.Image.BACKGROUND_EXPORT functions
could not be used sequentially.
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• BUG ID 273617 - In theNode Graph palette, the following Edit > Bake Points context menu items have been
renamed to:

Original name Updated name

Update Selected Bake Points Update Selected

Update DownstreamBake Points Update Downstream

Bake Empty and UpdateOut-Of-Date Bake Points Smart Bake And Update

Bake Selected Bake Points Bake Selected

The Python functions have also been changed to match the new names, pleasemake sure to update your scripts .
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